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InDesign Introduction 

What do I need to know in order to create my magazine cover in InDesign? 

Typography Tips for Layout Design 

Illustrator Introduction 

What are the most important things to know about Illustrator in order to make a logo? 

Photoshop Basics for Image Editing 

 

Assignment 2_Part 6: InDesign Introduction 

 

What is InDesign? 

InDesign is a program used in the publishing industry to lay out multi-page documents. We will use this 

program to put our initial cover and magazine together, after creating more specific designs in 

Illustrator and Photoshop. 

 

What is the difference between InDesign, Illustrator and Photoshop? 

InDesign and Illustrator are vector programs--they use mathematical functions to display what you see 

on the screen. All vectors, or lines or paths, are positioned by definite points on the x and y axes, and 

therefore are not affected by the size of the document, unlike raster programs that use pixels 

(bitmaps) to display information (Photoshop). 

  

How will I specifically use each program? 

InDesign: laying out large amounts of information across multiple pages 

Illustrator: Manipulation of text and creating custom art  

Photoshop: Bitmap editing and manipulation 

 

What is the difference between a document, a book, and a library?  

Document: Used for small documents, like our magazine, created by an individual or a small group. 

Book: Used for larger documents, like a book, journal, or reference material, managed by a group. 

Library: A place to save common elements. The library  appears as a panel within the program. 

 

After I open InDesign, what do I do? 

You choose new document. You adjust the page for the size you need it. In this class, we will use these 

dimensions:  8.25 X 10.75i. The company that we send our magazines to print will cut down our 

magazine to this size, therefore it needs to be designed to this size.  

 

What type of measurement is 51p X 66p (the default page size in InDesign)? 

P stands for pica. It is a typographic measurement and is the default unit used in InDesign. There are 

six picas in an inch. There are 12 points in a pica. You should be familiar with points, since you have 

probably adjusted the size of your type in programs like Word, i.e. 12pt font. You can change the unit 

(to inches, for example) after the document is created by visiting Edit →  Preferences → Units & 

Increments. 

 

You also want to make sure your margins are at least .5 in. (or 3 picas). Magazine readers like to have 

thumb room, so that they don’t cover any content, so make sure all of your text fits in the margin for 

easy reading.  

 

Pictures do not have to fit within the margins. In fact, if you want a picture to go to the edge of the 



page, you can add bleed marks to your document. Bleed marks are in place so that designers know how 

far to pull the picture to ensure that it reaches the edge of the page, no matter the margin of error 

from the print shop when they cut the file down. The purple line is the margin, the black line is the 

edge of the page and the red line is the bleed line. The space between the bleed and the edge of the 

page will be cut off, but it won’t be perfect, so pull all content that you want to reach the edge of the 

page at least to the bleed. 

 

 

 



 

What do I need to know about the layout of the workspace in InDesign? 

There are three main areas in every Adobe program: Tools Panel, Control Panel, and Panel Dock. 

 

Tools Panel: Your tools panel has all of the tools available to use in the program. You will always have 

some tool from that panel selected, even if it’s only the selection tool. You can move the tools panel 

wherever you want to within the workspace. If you hover over each tool, you will see a yellow flag that 

displays the tool’s name and keyboard shortcut.* On some tools, you will see a small black triangle in 

the bottom right-hand corner of the tool button. That indicates that there is more than one option for 

that tool. Simply hold down the button to select another tool.  

 

Example:  

 

 

 

 

 

 

Control Panel: Your control panel has lots of things that you can, well, control. There is one important 

thing to remember about the control panel: It displays relevant controls depending upon which tool you 

have selected. Again, you can hover over any control and a yellow flag will appear, telling you the 

control name.* 

 

*This class moves very quickly when it comes to software. One of the most important skills to take 

away from this class is learning to be resourceful. If you are unsure of what a tool does, look it up using 

the name on the yellow flag. You can Google it, or you can use the Adobe Help Menu. Believe it or not, 

but there are some tools that I am not proficient with. Gasp! Also, if there is a problem that you can’t 

figure out--Google that, too. Many times, someone else has had that problem like you and has posted 

the solution. You’ll be surprised at how quickly you will pick up the programs if you look up stuff that 

you don’t know.  

 

Panel Dock: The panel dock is on the right side, by default, but individual panels can be undocked and 

moved anywhere in the workspace for easier access. Panels offer more detailed controls of tools and 

objects. Keep in mind that things that are on the control panel for easy access might also have an in 

depth panel as well. For example, you can adjust the size and font of text on the control panel, but 

there is also a Character Panel on the panel dock that allows you to do the same thing.  

 

Example: 2 ways to control text: Control Panel and Character Panel* 

 

*If you ever close out any panel, you can restore by going to Window → [Find panel] 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

On each panel, there is a menu of items which allows you to select more options within the panel. 

 

 

 

 

 

 

 

 

There is one final menu that you will use often: Context Menu 

 

Depending on what you are doing, when you right click on an object or text, a context menu will pop 

up. Everything in the context menu is available either in a panel or on the control panel, but InDesign 

wanted you to have information specific to what you were clicking on (in context) available to you 

quickly. 

 

 

What will I need to know how to do in InDesign to recreate a sample magazine layout and our group  

style sheet layout? 

 

1. Set up the correct page size with proper bleed and margins.You’ll probably want to create a two 

page document--one for your logo and one for your style sheet sample.  

 

Dimensions:  8.25i x 10.75i or 49p6 x 64p6 

Bleed:  

Top 0p9 or .125i  

Bottom 0p9 or .125i  

Inside 0p or 0i 

Outside 1p6 or .25i 

Margins: 3p or .5i 

 

 

2. Utilize different tools to achieve different effects. Here are some tips for basic text manipulation. 

 

Mix serif with sans serif fonts. When you use the same type of font for all of your text, you run the risk 

of  boring the reader. Mix up your fonts, but BEWARE, too many fonts can be distracting, so find two or 

three good ones and mix up the weight, size, cases (uppercase and lowercase), and fill/stroke. Also, 

not all fonts are perfect--you may have to adjust your kerning, tracking, and leading. By creating 

outlines from your type, you can use tools to change the shape of the letters.  

 



If you want to change the characteristics of the text, you must highlight it with the text tool. You can 

change the font, size, fill and stroke of text that is highlighted. This can be done on the control panel 

or using the character panel on the dock. Let’s take a closer look at some of these characteristics. 

 

 

Let’s get to work and learn some important tools within InDesign. 

 

TOOLS 

1. _______Isolate an anchor point using the direct select tool. 

2. _______Draw a shape with the pen tool. (a box and a heart) 

3. _______Add, delete and convert an anchor point into a curve using the pen tool. 

4. _______Using the type tool, draw a text box and change the basic characteristics of the 

word/sentence/paragraph. (fill, stroke, size, kerning, tracking, leading, etc.)  

5. Type on a path using the horizontal AND vertical type tool. 

6. ________Make a line with the line segment tool.  

7. _______Use the shape tool to draw a variety of shapes. 

8. _______Locate and use the rotate tool.  

9. _______Find the fill and stroke boxes and change the fill and stroke of an object. 

 

CONTROL PANEL  

10. _________Apply a fill and stroke to text and objects. 

11. _________Find the text wrap options in the control panel and learn the different options.  

12. _______Adjust the opacity of an object. 

13. ________Apply a drop cap to the beginning of a paragraph.  

14. ________Learn how to set tab stops. 

15. ________Create outlines from text and manipulate the shapes of the letters (by isolating anchor 

points). Warning: Once you turn text into an object, you can no longer change the font size or apply 

text effects as you normally would. Illustrator now sees your wording as an object.  

 

PANELS 

16. _______Find the Pages Panel and learn how to add pages and remove pages. Learn how to move 

pages around.  

17. _______Find the Layers Panel and learn how to rename, move and lock layers and sub-layers. 

18. ________Find the Character and Paragraph Panel and keep it handy.  

19. ________Locate the Stroke Panel and learn how to apply different strokes. 

20. _______Find the glyphs panel.  

 

CONTEXT MENU 

21. ______Fill a text box with placeholder text and learn how to thread text. 

22. ______Arrange objects and text from front to back.  

 

Some helpful tips: 

1. Ctrl + Alt + I: Toggles hidden characters 

2. Double clicking on a word highlights the word, triple clicking on the word highlights the sentence 

and clicking five times will select the whole text frame. 

3. When text is highlighted, you can click Ctrl + Shift with the < and > symbols to scale text.  

4. standard text size for magazine design: 10pt/12pt leading. Do not use anything over 11! 

 



 

 

 

 

Assignment_5_Part 2: Images in Layouts 

 

 

 

Place an image that has proper resolution and maintains proportion of the original image after 

cropping. 

 

---Start with some good sites: Google Images, Flickr Creative Commons, istockphoto, everystockphoto 

and www.sxc.hu are popular. (Later in the semester, you’ll learn how to get permission or find out the 

copyright status, but for this project, it is not necessary since we are not publishing these versions of 

the  covers.) 

 

---Keep in mind that cover images have a focal point with minimal distractions. A photo with space at 

the top to accommodate a logo is best, along with some room on the sides for cover lines. Off-center 

photos are popular, as they provide adequate spacing for text. Let’s find some photos that would be 

good for cover photos. 

 

---Check the size of the photo. A pixel is the smallest element of an image represented on a screen. 

The dimensions will likely be in pixels (7216 X 5412 or 40 MP for example). The first number tells you 

how many pixels wide the image is; the second tells you how many pixels tall the image is. Here is a 

list of Google Image’s photo sizes converted to inches. 

 

---Most photos online are saved at 72 pixels per inch. For print, your photo will need to be at least 

300 pixels per inch. That means you’ll need to divide your photo’s measurements (the width and the 

height) by 300. For example, if I find a 7216 X 5412 pixel photo, that would give me a 24 in X 18 in 

photo (7216 pixels ÷ 300 pixels/inch = 24 inches and 5412 pixels ÷ 300 pixels/inch = 18 inches). 

 

---Make the appropriate size rectangular frame box in your InDesign document to accommodate your 

photo, then place your photo (either through “File, “Place” or through Ctrl+D) from its location. Using 

InDesign’s cropping function, you can select the photo inside the frame and move or resize, so long as 

you aren’t below 300 ppi. If your picture looks pixelated, but the ppi is correct, it might just be a 

display setting. Right-click on the picture to show your Context Menu, go down to Display Performance 

and click on High Quality Display. If that doesn’t fix the display, there might be something wrong with 

your resolution. 

 

---Check your links panel. This will tell you where your photo is saved (for future projects, we will save 

them on the Ezine server) and its “actual” and “effective” PPI. The “actual ppi” is the photo’s original 

resolution; the “effective ppi” is the print quality. You want to look at the “effective ppi” and make 

sure it’s at least 300. 

 

 

 

 

 

http://www.google.com/imghp?hl=en&tab=wi
http://www.flickr.com/creativecommons/
http://www.istockphoto.com/
http://www.everystockphoto.com/
http://www.sxc.hu/
https://docs.google.com/document/pub?id=1NQMtDYJggIWrWOjgbx7P5LCxb9pgaWZh3U9JAI3Pnb4


 

 

Assignment 5: Part 2: Photoshop Basics for Image Editing 

 

What is Photoshop? 

Photoshop is a program used to manipulate pixels in an image file. 

 

What is the difference between InDesign, Illustrator and Photoshop? 

InDesign and Illustrator are vector programs--they use mathematical functions to display what you see 

on the screen. All vectors, or lines or paths, are positioned by definite points on the x and y axes, and 

therefore are not affected by the size of the document, unlike raster programs that use pixels 

(bitmaps) to display information (Photoshop). 

 

How will I specifically use each program? 

InDesign: laying out large amounts of information across multiple pages 

Illustrator: Manipulation of text and creating custom art 

Photoshop: Bitmap editing and manipulation 

 

What should I know how to do to my images in Photoshop before I put them into my magazine? 

1. Unlock the background picture OR create a duplicate layer in order to edit your image.  

2. Understand how layers work and that each time you use the text tool, a new layer will be created. 

3. Change your image into CMYK. 

4. Auto color, tone, and contrast your picture. 

5. Use the magic wand, background eraser, or lasso tool to outline an object in a photo AND remove the 

background. 

6. Change the photo into black & white. 

7. Understand why you would need to save as a .jpg, .psd, or .png. 

8. Adjust the brightness/contrast of a photo WITHOUT making changes to the original photo. 

9. Apply a filter to the photo using the effect gallery. 

10. Learn the benefits of using a layer’s blending mode.   

11. Learn the following shortcuts:  

 

Ctrl + T  Transform the size, shape of the layer 

Ctrl + D  Deselect 

For the easy access to the hand tool, press spacebar.  

 

Also, we want to make our pictures a bit brighter, because when we print them out, they will be a bit 

darker than what you see on screen. 

 

Assignment 6, Part 2: Illustrator Introduction 

 

What is Illustrator? 

Illustrator is a program used in the graphic design industry to create custom vector art. We will use this 

program to create our logo and to add custom artwork and illustrations to layouts within the magazine. 

 

What is the difference between InDesign, Illustrator and Photoshop? 

InDesign and Illustrator are vector programs--they use mathematical functions to display what you see 

on the screen. All vectors, or lines or paths, are positioned by definite points on the x and y axes, and 



therefore are not affected by the size of the document, unlike raster programs that use pixels 

(bitmaps) to display information (Photoshop). 

 

How will I specifically use each program? 

InDesign: laying out large amounts of information across multiple pages 

Illustrator: Manipulation of text and creating custom art 

Photoshop: Bitmap editing and manipulation 

 

After I open Illustrator, what do I do? 

You choose the number of art boards that you would like. If you are going to work on multiple things, 

you might want to have more than one. For instance, if you are designing a business card, you might 

want to have two art boards, one for front and one for back. But, for most individual art, one board is 

plenty. 

 

Illustrator allows you to choose the unit of measurement you prefer. It doesn’t really matter what you 

choose, as long as you are designing your art to fit the magazine. For your logo, you’d probably want to 

make your artboard at least 8.5 inches X 5 inches. Imagine how much space it will take up on your 

magazine cover. 

 

Under Advanced Settings, you are able to select the color mode you want your document in. If you are 

printing the document, you will design in CMYK, if you are putting your design online only, you will use 

RGB. Print work uses 4 inks (Cyan, Magenta, Yellow and Key Black) and display screens use three lights 

(Red Green and Blue) to mix any color available in each spectrum. But for now, just remember: PRINT = 

CMYK, SCREEN = RGB. Also, you will want the raster effects to be at 300 PPI, since we are printing our 

magazines and that is the number of pixels per inch needed for printed material to come out crisp. The 

pixels per inch for screen is only 72 ppi, so if you are creating a logo just for a blog, then that’s as high 

as you would need it. But for our magazine logos, we’ll need 300ppi. 

 

What do I need to know about the layout of the workspace in Illustrator? 

There are three main areas in every Adobe program workspace: Tools Panel, Control Panel, and Panel 

Dock. 

 

Tools Panel: Your tools panel has all of the tools available to use in the program. You will always have 

some tool from that panel selected, even if it’s only the selection tool. You can move the tools panel 

wherever you want to within the workspace. If you hover over each tool, you will see a yellow flag that 

displays the tool’s name and keyboard shortcut.* On some tools, you will see a small black triangle in 

the bottom right-hand corner of the tool button. That indicates that there is more than one option for 

that tool. Simply hold down the button to select another tool.  

 

Example:  

 

 

 

 

 

 

Control Panel: Your control panel has lots of things that you can, well, control. There is one important 

thing to remember about the control panel: It displays relevant controls depending upon which tool you 



have selected. Again, you can hover over any control and a yellow flag will appear, telling you the 

control name.* 

 

*This class moves very quickly when it comes to software. One of the most important skills to take 

away from this class is learning to be resourceful. If you are unsure of what a tool does, look it up using 

the name on the yellow flag. You can Google it, or you can use the Adobe Help Menu. Believe it or not, 

but there are some tools that I am not proficient with. Gasp! Also, if there is a problem that you can’t 

figure out--Google that, too. Many times, someone else has had that problem like you and has posted 

the solution. You’ll be surprised at how quickly you will pick up the programs if you look up stuff that 

you don’t know.  

 

Panel Dock: The panel dock is on the right side, by default, but individual panels can be undocked and 

moved anywhere in the workspace for easier access. Panels offer more detailed controls of tools and 

objects. Keep in mind that things that are on the control panel for easy access might also have an in 

depth panel as well. For example, you can adjust the size and font of text on the control panel, but 

there is also a Character Panel on the panel dock that allows you to do the same thing.  

 

Example: 2 ways to control text: Control Panel and Character Panel* 

 

*If you ever close out any panel, you can restore by going to Window → [Find panel] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On each panel, there is a menu of items which allows you to select more options within the panel. 

 

 

 

 

 

 

 

 

There is one final menu that you will use often: Context Menu 

 

Depending on what you are doing, when you right click on an object or text, a context menu will pop 



up. Everything in the context menu is available either in a panel or on the control panel, but InDesign 

wanted you to have information specific to what you were clicking on (in context) available to you 

quickly.  

 

What are the most important things to know about Illustrator in order to make infographics? 

 

TOOLS 

1. _______Isolate an anchor point using the direct select tool. 

2. _______Draw a shape with the pen tool. (a box and a heart) 

3. _______Add, delete and convert an anchor point into a curve using the pen tool. 

4. _______Type on a path using the horizontal AND vertical type tool. 

5. _______Find and use the paintbrush tool to draw something. 

6. _______Use the shape tool to draw a variety of shapes. 

7. _______Locate and use the rotate tool.  

8. _______Using the scale and shear tool, make adjustments to objects and text (although, be aware 

that scaling whole words and large bodies of text diminishes the craft and intricacies of a typeface--a 

typographer’s NIGHTMARE! 

9. ________Make a line with the line segment tool. Alt + Click and drag to copy. Then press Ctrl + D to 

copy over and over at the same width. This might prove useful to you later. 

 

CONTROL PANEL  

10. _________Apply a fill and stroke to text and objects. 

11. _________For a line drawn with the paintbrush tool, adjust the stroke weight, definition and width 

profile to achieve different effects.  

12. _______Adjust the opacity of an object. 

13. ________Create outlines from text and manipulate the shapes of the letters (by isolating anchor 

points). Warning: Once you turn text into an object, you can no longer change the font size or apply 

text effects as you normally would. Illustrator now sees your wording as an object.  

 

PANELS 

14. _______Make two different shapes. Put one on top of the other and using the Pathfinder Panel, 

explain the function of the following shape and pathfinder modes: Unite, Minus Front, Intersect, 

Exclude, Divide, Trim, Merge, Crop, Outline, Minus Back. 

15. _______Find the Layers Panel and learn how to rename, move and lock layers and sub-layers. 

16. ________Using the Appearance Panel, apply a drop shadow and rounded corners to a square. (Can 

also be found in the Effect Menu on the Control Panel.) 

17. ________Also using the Appearance Panel, apply a double stroke to an object and discover how 

that could be useful.  

18.  ________Within the Appearance Panel, warp text using the variety of options available. (Can also 

be found in the Effect Menu on the Control Panel.) 

19. ________Open the Appearance Panel and find out how to apply and delete effects from that panel. 

(It is helpful to always have this panel open to see any effects applied to a selected object.) 

20. ________Using the Gradient Panel, apply a gradient to an object and adjust the color options.  

 

SHORTCUT TIPS: 

CTRL + Scroll: Allows you to quickly scroll to the left and the right. 

ALT + Scroll: Allows you to quickly zoom in and out. 

F: Toggle between screen modes: Normal Screen Mode, Full Screen Mode with Menu Bar, Full Screen 



Mode. 

Spacebar: Switch to Hand Tool when not in text mode. 

CTRL + SHIFT + H: Show/Hide artboards 

 

 

Try this NINJA tutorial! You can check off quite a bit from the list above! 

http://blog.spoongraphics.co.uk/tutorials/illustrator-tutorial-create-a-gang-of-vector-ninjas 

 

Other helpful links:  commonly used tools, Illustrator Drawing Basics, Adobe’s Help Page for Illustrator 

 

Stay curious about what Illustrator can do. Don’t get discouraged! It takes YEARS for designers to 

maneuver easily throughout this program, so there’s no way you are going to be an Illustrator genius in 

just three short months. When you get frustrated, talk with your peers or your instructor about what 

you want to do and we can figure it out together! 

 

 

 

 

http://blog.spoongraphics.co.uk/tutorials/illustrator-tutorial-create-a-gang-of-vector-ninjas
http://help.adobe.com/en_US/illustrator/cs/using/WS14386A18-6B9B-436d-8FF1-B98770564424.html
http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0100196cbc5f-6269a.html
http://helpx.adobe.com/illustrator/topics.html

